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Software Overview

Software Overview
Each class of logger has a unique device type and identifies itself when queried by the host computer. Therefore, only one software
package and manual are required for all OM-CP data loggers. In certain instances where differences occur, this manual will answer
potential questions and provide clarification.
The OM-CP Data Logger Software is designed to streamline the process of downloading data and reviewing it. The software
automatically configures itself specifically to each class of logger by reading the device type with the ability to change engineering
units (dependent upon specific data logger models), conforming to the needs of its user.

Getting Started
System Requirements
OM-CP Data Logger Software requires the following:
•
•
•
•

Windows XP SP3 or later
4GB (or more) RAM
At least 30MB free hard disk space (for installation); 1 GB recommended
Available USB port (for USB logger interface cable)

(Note: Although the software is designed to work with the Windows Operating Systems listed above, Omega cannot guarantee operation
on OS’s no longer supported by Microsoft Support Life Cycle Policy.)

MAKE SURE NO USB INTERFACES ARE PLUGGED IN UNTIL THE FULL SOFTWARE INSTALLATION IS COMPLETE
Software Installation
OM-CP Software can be downloaded from the Omega website or installed from the provided Omega flash drive.
To install the OM-CP Software from a flash drive:
1. To begin installation, insert the flash drive that was provided with the data logger into an available USB port. After a few moments
an AutoPlay box will open.
2. In the AutoPlay box, click Open folder to view files to view the contents of the flash drive.
3. In the case that the AutoPlay is disabled, manually browse to the Omega flash drive by clicking on the File Explorer Icon in the
Task Bar and click on USB Drive in the options on the left to see the contents.
Double-click the autorun.exe (application) to launch the OM-CP Software Installer Options.
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The Omega installer options screen will launch.
1. Choose the Omega Software option to install the OM-CP Software.
2. Choose the Install USB Interface Drivers option to install drivers for use with
USB interface cables and accessories. (see below)
3. Click Omega Software to open the Omega Software options page.
The OM-CP Software requires the .NET Framework 4.0 to be installed on the
intended PC. The Windows 8 and Windows 10 operating system comes with a
newer version of the .NET Framework already installed. If the .NET Framework
4.0 has not been installed on the PC, click the Install .NET Framework 4.0 option
and walk through the wizard installation steps.
(Note: If the .NET Framework 4.0 has already been installed and you select the
Install .NET Framework 4.0 option, a window asking to Repair or Remove the .NET
Framework 4.0 will appear. It is recommended to select the Cancel button when this
page appears.)
After the .NET Framework 4.0 installation has been confirmed, click the Install
Omega Software option. Select English when prompted for a language selection,
then the Installation Wizard will walk through the installation steps to install the
software.
The following are examples of the installation windows:

When the Installation Complete screen appears, click Finish to exit the wizard and return to the autorun, then Exit at the bottom to
close the autorun. The OM-CP Software is now installed on your PC.

Installing the USB Interface Drivers
The USB interface drivers can easily be installed on the PC if they are not already available and running. The Install USB Interface
Drivers option will install Windows device drivers for the Omega USB interface cables.
1. Click Install USB Interface Drivers from the installer options screen.
2. Click Install in the window that appears.
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Starting the Software
To begin, launch the software by simply double clicking the desktop icon, clicking the icon in the Quick Launch toolbar (if applicable),
or clicking the OM-CP Data Logger Software icon in the Start Menu.

Shutting Down the Software
There are a few different ways to shut down the software.

Shut Down: File Menu
To shut down the software using the file menu:
1. Click the File tab.
2. Click the Exit Application button in the bottom right corner of the menu.

Shut Down: X Button
To shut down the software using the X button:
1. Click the X button in the top right hand corner of the software screen.

Shut Down: Keyboard Shortcut
To shut down the software using the keyboard shortcut:
1. Simultaneously press Alt+F4 on the keyboard.
If the current report has been saved, the report settings and customizations will be maintained when shutting down the software. If the
current report has unsaved report settings or dataset, the software will prompt the user to save before shutting down.

Uninstalling the Software
Uninstalling the OM-CP Data Logger Software is easy and can be done
through the operating system on the user's computer.
To uninstall the OM-CP Data Logger Software:
1. Click the Start menu.
2. Type “Programs” and select Add or Remove Programs or Programs
and Features from the search results.
3. Use the scroll bar to locate OM-CP Data Logger Software in the list.
Then highlight the program within the list and select Uninstall.
4. A message will appear. Click Yes to uninstall the software. Click No to
keep the software and cancel the action.

Uninstall or change a program screen
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Software Menus and Navigation
Each section of the software will be explained briefly in the following pages. Please refer to the software help menu for more
information or Troubleshooting section.

Tab Options

File
Database

Menu Bar
(Changes depending
upon the selected tab)

Help Button

Minimize, Full
Screen and Close
option buttons

Connected Devices and Files Panels

Panel

Channels

Graph Display Panel

Panel
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The File Menu
Within the first upper left tab titled File, there are many different options
that appear. Below is a brief description of every item.
• New: Creates a new blank report.
• Open: Opens a report saved outside the software.
• Save: Saves the file to the file database.
• Save To: Saves reports as an MTFF file.
• Import Files: Imports files from locations outside of the software.
• Import Folder: Imports folders from locations outside of the software.
• Print: Prints the selected open report.
• Close: Closes the selected open report.
• Recent Documents: The side bar will show any recent documents that have
been opened or saved.
• Options: Many software settings and defaults can be managed and edited here.
• Exit Application: Closes the software.

The Options Menu
The Options button, located at the bottom right section of the File tab, offers a variety of options that affect the appearance and
default settings of the software.
• Device: Change device settings of a logger regarding
calibration notifications and importing engineering units
from the currently connected devices.
• Display: Edit the default settings when the software opens.
•

Page display allows the user to choose what
measurement the page display can be: inches,
millimeters or centimeters.

•

Viewing data allows the user to edit the time format
and channel grouping.

•

Cooling flags allows the user to choose the default
cooling flags that can be displayed.

•

The Layout section allows the user to edit the ability to minimize to the system tray, the overall software color scheme, and
reset the screen layout.

•

Language allows the user to change the default language.

• File: Change how files are imported and the location of Preferences and Alarm log folders.
• Reports: Customize default report properties.
• Alarm: Configure pre-defined comments when acknowledging alarms.
• Units: Change the default colors and units for the various unit types.
• Address Book: Manage the contacts within the software.
• Email Settings: Manage the server address, port and email authentication settings.
• Communications: Configure and display detected interfaces.
• Reporting: Change the software problem and usage reporting preferences.
• Wireless: Configure wireless timeouts.
• Interop: Software built using the Windows Communication Foundation (WCF) can retrieve real-time readings from data loggers
connected to the OM-CP Data Logger Software.

10

Software Overview

The Device Menu
The Device tab, located at the top of the menu bar, contains all of the features for managing devices. Within this tab are four different
sections: Control, Alarms, Information, and Wireless. Below is a list of commands and options found in the device menu.

Custom Start - Start the selected device(s) using
custom settings.

Manage Rules - Manage real-time alarm rules.

Quick Start - Start the selected device(s) using the
current settings.

Alarm Log - Displays alarm notification history.

Real Time Start - Start the selected device(s) in realtime mode.

Properties - View the properties and settings of the
selected device.

Batch Start - Automatically start devices of the
same type as they’re connected.

Engineering Units - Manage engineering units.

Stop - Stop the selected device(s).

Claim - Add the selected wireless device(s) to the
network.

Download - Download recorded data from the
selected device(s).

Release - Remove the selected wireless device(s)
from the network.

Reset - Resets the selected device(s).

Locate - Find or identify a wireless device with an
audible alarm.

Workflows - Manage device automation workflows.
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The Report Menu
The Report tab, located at the top of the menu bar, contains all of the features and options for managing reports. Within this tab
are five different sections: Graph, Data Table, Statistics, Channels & Readings, and Report Options. Below is a list of commands and
options found in the report menu.

Generate - Generates a graph based
on the current report, or a blank
graph if no report is open.

Timeslice - Manage timeslice
options.

Device Properties - View the
properties of the selected channel’s
associated device.

Select - Change the cursor function
to select data points.

Cooling Flags - Set annotations
for multiple temperature cooling
points.

Math Channels - Manage channels
that generate values based on
specified calculations.

Fit to View - Zoom out to fit all data
in view.

Value Lines - Horizontal lines for
Minimum, Max, Average Mean Kinetic
Temperature, and Fixed Line values.

Remove Channels - Remove the
selected channel from the current
report.

Box Zoom - Change the cursor
function to zoom in on a selected
area.

Line Thickness - Changes the
thickness of the value lines in the
graph.

Add Annotation - Add a comment
to the graph.

Horizontal Zoom - Change the
cursor function to zoom in on a
selected length of time.

Line Color - Changes the color of
the value lines in the graph.

Unit - Change the unit for the
selected channel.

Vertical Zoom - Change the cursor
function to zoom in on a selected
unit range.

Background Color - Changes the
background color of the graph.

Channel Grouping - Change how
the channels are grouped; Serial
Number, Device ID and Device name.

Set Scale - Set the scale of the
graph.

Generate - Generate a new data
table based on the current report, or a
blank data table if no report is open.

Lock Vertical Scale - Lock the
vertical scale of the graph.

Generate - Generate a new statistics
view based on the current report, or
a blank view if no report is open.

Enable Autoscroll - Allow the graph to
automatically scroll along the time axis
as real-time data points are added.

Add/Remove - Manage custom
statistic information.

Axis Positions - Change which side
of the graph each axis is positioned.

Time Markers - Allows graphs to
be displayed with cycle duration
properties.

P

Report Properties - View details
about the current report.
Export to Excel® - Copy the data
of the current report to Microsoft
Excel®.
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Screen Navigation
The OM-CP Data Logger Software offers a display with nearly limitless report capabilities and customization features. Users now have
the opportunity to arrange the display screen to suit specific needs such as size, placement, and information accessibility.

File Database
The File Database panel contains several different folders where reports can be
saved or deleted. Users can also create new folders to help organize datasets
and reports.

Channels Panel
The Channels panel displays the different channels within the current open
report. If no report is open, the panel will be blank.

File Database Panel

Channels Panel

Connected Devices
The Connected Devices panel displays a list of devices that are connected to
the PC or available through wireless transmission. A device in this panel must be
selected in order to enable any device specific features.

Connected Devices Panel

Files
The Files panel displays the contents of the folder selected in the File Database
panel.
Users can toggle between the Files panel and Connected Devices panel
depending on their intended use of the software at that time.
On each of the panels header bar there is a downward pointing arrow icon
and a pin icon. Clicking on the pin icon will cause the panel to auto hide and
become a tab in the left margin. To view the contents when the panel is hidden,
hover the mouse over the hidden panel’s header. A context menu is available
with the following options:

Files Panel

• Float: This allows the selected panel to float and can be moved anywhere
on the screen. A panel can also float by clicking on its header, holding and
dragging it anywhere on the screen, then releasing it.
• Dock: This option locks the selected panel in its original position.
• Dock As Document: This option adds a panel to the report tab group.

Hovering over the pin icon will
allow the panel to be hidden

Hovering over the arrow icon will
show a variety of options

• Auto Hide: This option hides the panel so only the header is visible.
• Close: This option closes the panel.

Hovering over a hidden panel will display the contents of that panel.
Note: the pin icon now points to the left.
Floating Datasets Panel
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Rearranging Panels
In addition to the hiding and floating panel options, panels can also be manually rearranged to meet user preferences.
To rearrange a panel:
1. Click and hold the header of the panel.
2. Move the mouse in the direction of where the panel’s new location will be. A highlighted blue section
will move with the mouse to act as a preview for the panel.
3. Move the mouse to the desired Placement option, then release the mouse.
•
•
•
•
•

The top option will place the selected panel above the panel in which the image appeared in.
The right option will place the selected panel to the right of that panel.
The left option will place the selected panel to the left of that panel.
The bottom option will place the selected panel below that panel.
The center option will place the selected panel on top of that panel, adding a tab to switch
between panels. (Note: Not all panels support the center option.)

Optional Placement of the panels

Below are sample screens of the steps to rearrange the Channels panel. Now the Channels panel is above the chart window instead of
to the left as it was originally.

Restoring Default Windows
The software can easily restore the panels to the default screen layout.
To restore default windows:
1. Click the File tab and then click Options.
2. Click the Display tab.
3. Scroll to the bottom and select Reset screen layout. The software will display a
prompt to confirm the request. Select Yes.
4. It will return to the options panel, select OK to apply the changes. Any unsaved data will also be prompted by the software to be
saved.
5. If the report is open and has not been saved, the reset screen layout will not be applied.
14
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The Help Menu
The OM-CP Data Logger Software offers a comprehensive help menu to answer any questions the user encounters while using the
software. Users have the ability to search directly using key words or utilize the pre-formulated categories to navigate and find a
solution to the problem at hand.
• Using the contents portion of the help menu, there are
various sections that cover the most common topics.
•
•
•
•
•
•
•

OM-CP Software Help
Working with devices
Managing reports
Managing folders
Working with data
Appearance
Troubleshooting

• The index portion of the help menu allows searching for
one word.
• The search option of the help menu allows the user to
insert a question or phrase.
For more details about the help section, refer to
Managing Data, Folders and Reports, Maintenance, and
Troubleshooting sections of the manual.
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Working With Devices
In the OM-CP Data Logger Software, data can be viewed in graphical or tabular formats as well as summary and statistics views, which
are available for further analysis. The software features exporting to Microsoft Excel®, data annotation, digital calibration and more.

Connecting and Disconnecting a Device
Each data logger must be connected to the PC to allow communication with the device. The OM-CP wireless data logger series can
communicate wirelessly using an OM-CP transceiver. (sold separately)
The following steps should be used for connecting and disconnecting data loggers using the appropriate interface cable for that device.
To connect a device:
1. Plug the interface cable, USB cable from the docking station, or USB cable direct from the data logger into an available USB port
on the computer.
2. Connect the data logger to the interface cable, the included USB cable, or insert the data logger into the interface docking station.
(Note: The connection from the interface cable to the data logger varies depending on the interface cable and data logger being used.)
3. Once the data logger is connected to the PC, it will appear in the Connected devices panel.
To disconnect a device:
1. Disconnect the data logger from the interface cable, USB cable or remove the data logger from the docking station. (Note: Do not
disconnect the data logger while device settings are being applied.)

Connected devices panel
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Start a Device
When starting a device to record data, several options and start methods are available. Start settings can be specified before
deploying the device. Choose Custom Start to select or modify logging options or the devices can be started using the current
settings by selecting either Quick Start. The Real Time Start option allows the devices to report readings back to the central PC instantly.
The Batch Start option allows devices of the same model to be programmed with the same custom start settings.
Multiple devices can be selected by holding the Ctrl or Shift key, selecting additional devices, or pressing the arrow keys.
However, the devices selected must all be the same model in order for the start options to become available.

Custom Start
When starting a device using custom settings, the user can specify when
the device starts by choosing to start immediately or having a delayed
start and then a reading interval, which will vary depending on the
device and application. Additional options, such as the stop method
and enabling memory wraparound, (overwriting the internal memory
when the reading capacity is reached) are available depending on the
properties of the selected device.

Immediate Start
To start a device using custom settings for an immediate start:
1. In the Connected devices panel, select the device to start. The
device should be highlighted.
2. On the Device tab, in the Control group, click
Custom Start in the context menu.

Custom Start. Users can also right-click on the device and select Start, then

3. Select Now as the start method, and specify all desired settings.
4. Click Start.
5. When the device has been started, the status in the Connected devices panel will read Running.

Manual and Delay Start
Depending on the device, the user can manually start a data logger or perform a delayed start using the Custom Start option.
Manual Start
A data logger with the manual start function needs to be programmed in order for a Manual Start to be performed.
To manually start a device:
1. In the Connected devices panel, select the device. Confirm that the intended device is highlighted.
2. On the Device tab, in the Control group, click
Custom Start in the context menu.

Custom Start. Users can also right-click on the device and select Start, and then

3. Under the Start method section within the Start device screen, select the Manual radio button.
4. Choose any additional necessary start settings (such as reading interval, memory wraparound, stop method, etc.).
5. Click the Start button. The Start device box will close and the status column in the Connected devices panel will read,
Waiting for manual start.
6. To begin recording, please refer to the manual start method in the device’s product user guide.
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Delay Start
When using the Delay Start method, the user can decide when the data logger will begin recording by setting a time in the Custom Start
window. This method does not require the user to be present to start the device, as it will automatically start at the selected time.
To Delay Start a device:
1. In the Connected devices panel, select the device. Confirm that the intended device is highlighted.
2. On the Device tab, in the Control group, click
Custom Start in the context menu.

Custom Start. Users can also right-click on the device and select Start, and then

3. Under the Start method section within the Start device screen, select the Delay radio button.
4. Click the dropdown menu beside the Delay radio button and choose the start date and time.
5. Choose any other necessary start settings (such as reading interval, memory wraparound, stop method, etc.)
6. Click the Start button.
7. The status column in the Connected devices panel will read Waiting to start.
8. Once the selected start time has passed, click the Refresh Devices button if the device does not appear. (Note: A wireless device
will update on its own, otherwise the duration of the refresh will be long.)
9. The status column in the Connected devices panel will read Running.

Quick Start
When a device is started using the Quick Start option, it will start immediately using the most recent Custom Start settings. It is
important to make sure that the selected devices are properly configured before using Quick Start.
To Quick Start a device:
1. In the Connected Devices panel, select the device. Confirm that the intended device is highlighted.
2. On the Device tab, in the Control group, click
Quick Start in the context menu.

Quick Start. Users can also right-click on the device and select Start, then

3. When the device has properly been started, its status in the Connected devices panel will read Running.

Real Time Start
When a device is started in Real Time, reading data is transferred directly to the software in the form of a dataset and stored in the
software's internal database. The data can be viewed as a report at any time and will automatically update as new readings are received.
Wireless and non-wireless devices function differently when started in Real Time. Non-wireless devices must remain connected to the
computer to operate in Real Time, and will not record any data to internal memory.
To start a device in Real Time:
1. In the Connected devices panel, select the device. Confirm that the intended device is highlighted.
2. On the Device tab, in the Control group, click
then Real Time Start in the context menu.

Real Time Start. Users can also right-click on the device and select Start, and

3. Specify device start and stop preferences, as well as the reading interval in the
Parameters tab. Alarm rules can be configured in the Alarm Rules tab. (Note:
For more information about adding, changing or removing alarm rules, please
refer to the Alarms section of this product user guide.)
4. Click Start button.
5. If Display a graph when Real Time logging begins is checked in the Display
tab of the Options dialog, a graph will automatically appear containing the real-time data of the devices selected.
6. When the device has properly been started its status in the Connected devices panel will read Real Time.
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A device can also be started in Real Time when it is already running:
Under certain conditions a device can be started in Real Time when it is already running, if it is not a wireless device. The device must be
physically plugged into the computer, wraparound must be disabled and the reading interval must be 2 seconds or slower.
1. In the Connected devices panel, select the Running device requiring a Real Time start option. Its status will read Running.
2. In the Device tab, in the Control group, click

Real Time Start. (Note: The status will now read Real Time.)

3. In order to stop the device, Stop must be clicked twice.

Batch Start
When using the Batch Start option, one device is programmed and will specify the settings that other similar devices will use.
Selecting multiple devices before beginning a batch start is not required. (Note: Only devices of the same model and firmware can be
batch started together.)
A Batch Start is useful when a user has many duplicate or same model devices that need to be started with the same settings.
The Batch Start option allows the user to start all of the devices with the push of one button, instead of individually changing the
settings and starting each device individually, saving valuable time and effort.
The Batch Start will have the same start device settings screen as the Custom Start option.
Additionally, after the Start button is clicked, a Batch Start Log dialog box will appear
to inform the user when each device is starting and when it actually has been started.
To begin a Batch Start:
1. In the Connected devices panel, select the device to be used as a basis for the
Batch Start.
Batch Start. Users can also right2. On the Device tab, in the Control group, click
click on the device and select Start, then Batch Start in the context menu.
3. Configure settings and start the device that is plugged in by clicking Start.
4. Remove the first data logger from the docking station or disconnect the logger
from the interface, then place the next data logger into the docking station or
connect the next data logger to the interface. When the devices have properly
been started their status in the Connected devices panel will read Running or Waiting to Start. Repeat this step until all of the
intended devices have been started.
Any devices plugged into the PC that are the same model as the device used to configure the Batch Start will automatically start. Each
device shown as Started or Waiting to Start can then be unplugged.
The device will begin recording data once it has been started. Depending on the stop method selected, the device will continue to
collect data until manually stopped, it reaches memory capacity or it has reached the stop parameters chosen by the user. Once the
device has been stopped, the data collected can be downloaded into a dataset and used to generate any type of report.
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Stop a Device
When devices are currently recording data, running in Real Time, or waiting to start, users can choose to stop recording. Devices that
are stopped will no longer record data until configured to start again. The stop methods available will vary by model, but can include:
Manual Stop, Automatic Stop, and Readings Stop. These stop methods are designated when the device is started.
Multiple devices can be selected to stop by holding the Ctrl or Shift key and either selecting additional devices or pressing the arrow
keys. All of the devices that have been selected will be highlighted in the Connected devices panel.

Manual Stop
The Manual stop option is convenient and easy to set up. There is no information that needs to be entered in comparison to the
Automatic or Readings Stop methods. Manual stop is always available even when other stop methods are selected at startup.
To configure Manual Stop during startup:
1. On the Device tab, in the Control group, click
Custom Start.
Users can also right-click on the device and select Start, and then
Custom Start in the context menu.
2. Select the Manual radio button under the Stop Method section.
To manually stop a device:
1. In the Connected devices panel, select the device to stop.
2. On the Device tab, in the Control group, click
Stop. Users can
also right-click on the device and select Stop in the context menu.
(Note: With 101A data loggers, the Manual Stop option can enable a
pushbutton stop if the Manual Start option is also selected.)
If a device is both recording data and running in Real Time, Stop must be clicked twice in order to stop the device. Clicking Stop once
will only stop the Real Time recording, selecting Stop the second time will stop the data from recording.

Automatic Stop
The Automatic Stop method is time dependent. Users can set a future point in time, to stop a logger from recording. The user does
not need to manually stop the device, as it will stop automatically.
To configure the Automatic Stop method:
1. On the Device tab, in the Control group, click
Custom Start in the context menu.

Custom Start. Users can also right-click on the device and select Start, and then

2. Select the Automatic radio button under the Stop Method section.
3. In the dropdown menu next to the Automatic radio button, select the date and time when the device should stop recording.
4. To confirm the device has stopped recording, click the Refresh Devices button in the Connected devices panel. Now the status
column in the Connected devices panel will read Stopped.

Readings Stop Method
The Readings Stop method (model specific) is dependent on the number of readings the device records. For example, if the duration
of 20 is entered into the readings text box, the device will stop recording once it records 20 readings.
To configure the Readings Stop Method (model specific):
1. On the Device tab, in the Control group, click
Custom Start in the context menu.

Custom Start. Users can also right-click on the device and select Start, and then

2. Select the Readings radio button under the Stop Method section.
3. Enter the number of readings to record before stopping in the text box next to the Readings radio button.
4. Click Start to start the device with the selected settings.
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Downloading Data
When the data logger is recording, it stores the readings in its internal memory. To view the data, it must be downloaded from the device
and viewed as a graph, a data table, or statistics report in the OM-CP Data Logger software. Downloaded data will remain stored on the
device until the device is reset or restarted. (Note: The OM-CP Data Logger Software will not download the same data more than once.)

Download Data from a Device
To download data from a stopped device:
1. In the Connected devices panel, select the device to download data from.
2. On the Device tab, in the Control group, click
context menu.

Download. Users can also right-click the device and select Download in the

Automatically Display Reports of Data that have just been Downloaded
The user can also choose to have reports automatically appear to
display data that have just been downloaded.
To configure the appearance of reports:
1. Click the File tab, then click Options.
2. From the Options screen, click Display.
3. In the Viewing Data section, select the check box next to each
report type the user wants to automatically open when data is
downloaded from a device.

Download While Recording
Certain devices have the ability to download data in the software while recording. The reading interval must be 2 seconds or slower,
and the memory wraparound must be disabled.
To download data while the device is still recording:
1. In the Connected devices panel, select the device to download data from.
Confirm the intended device has been selected by making sure the device is
highlighted.
2. On the Device tab, in the Control group, click
Download. To the right is
an example of the dialog box that will appear, asking to stop the device from
recording.
3. Click Yes to stop the data logger and download the data. Click No to download the data and have the data logger continue to
record. Click Cancel to neither stop the device nor download any data.

Reset a Device
When the data stored in a device is no longer needed or when resetting the status of alarms and triggers is required, the device can
be reset. If the device is currently recording, it will stop before resetting. Once a device is reset, the stored reading data cannot be
recovered, so always confirm that all data is downloaded and saved before resetting the device.
To reset a device:
1. In the Connected devices panel, select the device to reset.
2. On the Device tab, in the Control group, click

Reset. Users can also right-click the device and select Reset in the context menu.

21

Working With Devices

Workflows
The Workflows feature allows the user to automate tasks to efficiently download data, create reports and more. A Workflow is a saved
set of instructions that tell the software to perform tasks when specified conditions are met. Workflows can be scheduled to run
at specific dates and times or when specific data loggers are connected to the PC. (Note: The OM-CP Data Logger Software must be
running for a scheduled Workflow to execute.)

Adding a Workflow
To add a workflow to the software:
1. On the Device tab, in the Control group, click

Workflows.

2. Select New on the right hand side of the window, and do the following:
a. Enter a name in the Name box
b. Select the conditions that need to be met before the actions occur.
c. Select which actions will occur.
3. Click OK.

Changing a Workflow
To change a workflow in the software:
1. On the Device tab, in the Control group, click the Workflows icon.
2. Select the workflow to change. (Note: A workflow must be disabled before it
can be edited)
3. Click Properties and change the workflow to fit the desired preferences.
4. Click OK.

Enabling or Disabling a Workflow
To toggle whether a workflow is enabled or disabled in the software:
1. On the Device tab, in the Control group, click

Workflows.

2. Select the workflow to enable or disable.
3. Click Enable or Disable, depending on the current status of the workflow.

Duplicating a Workflow
To duplicate a workflow:
1. On the Device tab, in the Control group, click

Workflows.

2. Select the workflow to duplicate.
3. Click Duplicate. In the box that appears, change the workflow settings to fit desired preferences.
4. Click OK.

Manually Running a Workflow
When a workflow needs to be performed prior to meeting the condition requirements that were set, a workflow can be run manually.
To manually run a workflow in the software:
1. On the Device tab, in the Control group, click

Workflows.

2. Select the workflow to manually run. (Note: A workflow must be enabled and not already running before it can be manually run.)
3. Click Run.

Deleting a Workflow
To delete a workflow:
1. On the Device tab, in the Control group, click the Workflows icon.
2. Select the workflow to remove and select Delete.
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Calibration
OM-CP data loggers are calibrated at the time to meet our published accuracy specifications at the time of shipment. Electronic
sensors may drift over time, and should be periodically calibrated to maintain accuracy. Users determine the appropriate calibration
interval based on their requirements, with the most common calibration interval being one year. Omega offers standard and custom
calibration services in an ISO17025 certified Calibration Lab. For users with suitable calibration equipment, it is possible to perform
basic calibration within the OM-CP Data Logger Software.
Calibration parameters, as well as the last calibration date, are stored within the device’s non-volatile memory and can be accessed
through the software. The software also allows the device to maintain calibration while being used on any computer. Some data
loggers can be calibrated using a single point to correct an offset. In most cases, a two point calibration is preferable to correct for gain
and offset errors. (Note: In most cases a very stable environment and accurate reference are required to perform an accurate calibration.
Omega cannot guarantee the accuracy of any device calibrated outside of Omega.)
There are two methods to input the calibration data into the device. First is the Gain and Offset option, which allows the user to enter a
gain and offset directly when calibrating. Second, the High and Low Values option. The calculation used for calibration is x = (y-b)/m.
The values these letters represent are seen below:
•
•
•
•

x = calibrated value
y = original device measurement
b = offset
m = gain

Another way of visualizing this calculation is:
• Calibrated value = (reading-offset)/gain

Gain and Offset Values
The default gain of 1 and offset of 0 do not affect the readings the device takes. The device should be set to the default gain of 1 and
offset of 0 before taking measurements used for a calibration adjustment.

High and Low Values
The alternative to entering gain and offset values directly is letting the software calculate them by entering device readings at two
reference points using the High and Low Values option. These reference points are called High and Low because devices are
generally tested at a low-range and a high-range value.
Example: A user wants to calibrate a HiTemp140. The low setting the user decides to use is 50 °C and the high setting the user decides
to use is 140 °C. These values are the reference values. At a stable environmental temperature of 50 °C, the device readings are 50.17 °C.
At 140 °C the device is reporting 139.98 °C. The device readings for this example would be 50.17 and 139.98.
Using the above data, the user would fill in the following information on the calibration screen, assuming a unit of °C:
Low
• Reference value: 50
• Device reading: 50.17
High
• Reference value: 140
• Device readings: 139.98
Using these values, the software calculates the gain and offset values and writes them to the device. The gain and offset values will be
subtracted or added to each reading downloaded from the device, and the data will be correct without any further manipulation.
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Calibrating a Device
Devices need to be calibrated on a regular basis to ensure readings are accurate. If device sensor information or other specifications
are provided with the logger, the user can calibrate a device themselves. Devices can also be sent back to Omega for calibration as well
for custom and certified calibrations.
For a user to calibrate a device with the software:
1. In the Connected devices panel, select the device to calibrate.
2. On the Device tab, in the Information group, click
Properties in the context menu.

Properties. Users can also right-click on the selected device and click

3. Click the Calibration tab. (Note: If the Calibration tab is missing, the device does not need to be calibrated. Recording the current
values is recommended, so the original calibration values can be restored if desired.)
4. Click the Calibrate button.

Click the Calibrate button in the Properties window to begin
the calibration process.

A series of Calibrate a device windows will appear.
If the device has more than one channel, select the
channels to calibrate and click Next.

Next, decide how to input the calibration data. Refer to
the explanations previously outlined in this section to
choose the appropriate option.
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High and Low Values

When the High and Low values option is selected, the
following screens will appear. (Note: Depending on the
device, the number of screens and units shown will be
different based on the different channels the devices have.)

Enter the values for the first channel. Click Next.

Enter the values for any additional channels. Click Next.

Click Write when the Confirm Calibration Settings
screen appears.
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Gain and Offset

When the Gain and offset option is selected, the
following screens will appear. (Note: Depending on the
device, the number of screens and units shown will be
different based on the different channels the devices have.)

Enter the values for the first channel. Click Next.

Enter the values for any additional channels. Click Next.

Click Write when the Confirm Calibration Settings
screen appears.
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Software Alarm Rules
There are two types of alarm settings: Software Alarm Rules and Device Alarm Rules. To find out more information on alarms that
can be modified through the device, please refer to the Device Alarm Rules section of this manual.

Alarm Rules
When a device is started in real-time, Software Alarm rules can be set to notify individuals when certain conditions are met. This
option is only available when a data logger is communicating with the software and started in Real Time.
The Alarm Rules option allows the high and low thresholds to be set, and high and low warning thresholds can be set if the device has
this feature. A visual alarm notification will be triggered within the software when the alarm parameters are exceeded. Alarm rules can
also be configured to send email notifications (or text messages via email) if the email server settings have been configured.

Adding an Alarm Rule
To add an Alarm Rule:
1. On the Device tab, in the Alarms group, click
Alarm Settings screen will appear.

Manage Rules. The Real Time

2. Click the New button. The Alarm Rule box will appear, complete the following
steps:
a. Enter a name in the Rule name box.
b. Select whether notifications will be sent when All conditions are met or
Any condition is met.
c. Select the conditions to meet before notifications occur in the Perform
actions when box.
• If additional conditions are needed, click the + sign to add a new
condition.
d. Select which notifications will occur in the When conditions are met box.
• If notifications need to be received by email or text message, click the
+ sign in the When conditions are met box. Select Send email or text
from the dropdown list and Add contact from the other dropdown list.
(Note: If the email settings are incorrect, email and text message notifications will not be received.)
e. Select whether notifications will only occur once or on a regular basis.
3. Click the OK button. The OK button will be disabled if the Rule name box is empty.

Changing an Alarm Rule
To change an Alarm Rule:
1. On the Device tab, in the Alarms group, click

Manage Rules.

2. Click the alarm rule to change.
3. Click the Edit button.
4. Change the alarm rule settings to fit application preferences.
5. Click the OK button.

Enable or Disable an Alarm Rule
To enable or disable an Alarm Rule:
1. On the Device tab, in the Alarms group, click

Manage Rules.

2. Click the icon in the Enabled column for the rule specified to toggle. The icon will be green for Enabled rules, and Red for
Disabled rules.
3. An Enabled rule will notify the user based on the conditions the user specified. A Disabled rule will not notify the user when its
conditions are met. The order of alarms can be rearranged by selecting an alarm and using the Move Up or Move Down buttons.
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Removing an Alarm Rule
To remove an Alarm Rule:
1. On the Device tab, in the Alarms group, click

Manage Rules.

2. Click the alarm rule to remove.
3. Click the Delete button. To delete all the alarm rules, click the Delete All button.

Dismissing an Alarm Rule Notification
If a notification is received that an alarm rule has triggered, users can choose to dismiss the alarm.
To dismiss an Alarm Rule notification:
1. On the Device tab, in the Alarms group, click Alarm Log.
2. Click the notification that needs to be dismissed.
3. Click the Dismiss button.
4. To dismiss all the notifications, click the Dismiss All button.

Alarm Acknowledgment
When logging data in real-time and an alarm notification appears, users can choose to acknowledge it. This will allow the user to
specify an action in response to the alarm and add comments. Pre-defined comment templates can also be configured for consistency
and workflow efficiency.
To acknowledge a software alarm:
1. Start the data logger in real-time and keep the report open. When an alarm is
triggered while recording data, in the Device tab, click
Alarm Log.
2. In the Alarm Log dialog box, choose the alarm from the list displayed and select
Acknowledge. Enter a title for the action, add an additional comment or select a
comment template for re-occurring alarm triggers if desired.
3. Select OK. An annotation will now appear on the graph report highlighting where
the alarm was triggered and display the added comment.
4. If there is more than one alarm, users can select multiple alarms by holding down
the Ctrl key and then select Acknowledge. Selecting Acknowledge all will apply
the same response to all selected alarms. To apply different responses to multiple
alarms, they must be selected individually.

Stopping Repeated Notifications for an Alarm Rule with a No Readings Condition
When setting up an alarm rule to continually notify when a device stops reporting readings, then the device becomes disconnected,
users can choose to ignore further notifications until the device reconnects.
To stop repeated notifications for an Alarm Rule with a no readings condition:
1. On the Device tab, in the Alarms group, click

Alarm Log.

2. Select the checkbox next to Ignore dismissed no readings notifications until the device reconnects.
3. Alternatively, the alarm rule that is sending the notifications can be disabled. However, disabling the alarm rule also means that
the user will not receive notifications if any other device meets its conditions.
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Adding a Comment Template for Software Alarm Rules
Adding a standard comment template within the software will decrease time spent typing the same comment repeatedly and allow
users to manage and track response options when an alarm is triggered.
Adding a comment template for software alarm rules:
1. Click the File tab, then click Options.
2. From the Options screen, click Alarms.
3. To create a new template click New. The Template name and
Comments fields can now be edited. Insert the desired template name
and enter the comments you would like to appear, then select OK.
4. The list of pre-defined templates will be available to the user and
displayed in the Alarm Log window when Acknowledge is selected.

Properties
The Properties box is where all of the device information and settings are located, and where changes to those settings can be made.
The following general information (varies by model and usage) can be found in the properties:
•
•
•
•
•
•

Revision
Device ID
Start date
Last set stop date
Time Zone last started
Readings

•
•
•
•
•
•

Battery level
Reading interval
Memory Wraparound status
Thermocouple type
Password
Operating Range

Other device specific settings such as Calibration, Channels, Power, Wireless
Information, and Alarm and Trigger settings can be viewed or changed by
accessing the Properties. The Properties feature can be found on the Device tab
in the Information group. Properties can be viewed but not changed for devices
that are currently recording or running in Real Time.

General Settings: Properties of a Specific Device
To view the properties of a specific device:
1. In the Connected devices panel, select the device to view the properties.
2. On the Device tab, in the Information group, click
in the context menu.

Properties. Users can also right-click on the device and select Properties

Many of the device properties require a reset before applying any of the changes made to the settings. Ensure that any data that needs
to be saved is downloaded and stored before resetting the device.

Checking the Power Status of a Device
Information about the power status of each device can be found in the Properties
box. The Power tab will provide information such as the battery level, external
power sources (varies by model), and if or when the device was last reset.
To view the power status information of a device:
1. In the Connected devices panel, select the device to view its power properties.
2. In the Device tab, Information group, click

Properties.

3. Select the Power tab. In the Power tab, all of the power properties available
can be viewed for the selected device.
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Changing the Thermocouple Type of a Device
A thermocouple is made of two dissimilar conductors that are connected. When
heated, they produce a voltage that can be correlated back to temperature. There
are different thermocouple types that refer to the contrasting metal combinations.
Each thermocouple type has a specific environment in which it can operate. If a
device has a thermocouple, the type of thermocouple used for recording can be
changed. The thermocouple type of the device must match the probe type or the
recorded data will not be accurate.
To change the thermocouple type of a device:
1. In the Connected devices panel, select the device.
2. On the Device tab, in the Information group, click
Properties. Users can
also right-click on the device and select Properties in the context menu.
3. On the General tab, change the Thermocouple type in the dropdown. If
the Thermocouple type dropdown is missing, the device does not have a
thermocouple.
4. Click Apply.

Add, Change, or Clear the Password of a Device
A password of a device that supports password capabilities can be set to protect it from being altered by unauthorized users. If the
device does not have password capabilities, no password information will be displayed on the Device Properties screen.

Setting the Password of a Device
Setting the password of a device is easy and simple. To the right is an example of the Properties box with no password set.
To set the password of a device:
1. In the Connected devices panel, select the device.
2. On the Device tab, in the Information group, click
Properties. Users can
also right-click on the device and select Properties in the context menu.
3. On the General tab, click the Set button.
4. Enter and confirm the password in the box that appears, and then click OK.
Below is an example of the box.
5. The software will display a message that the password has been successfully
written. Click OK.
Now that a password is set for the selected device, all users will be required to
enter the correct password before performing any tasks with the protected data
logger.

Changing the Password of a Device
At any time, users are able to change the password of a device that has currently has
a password.
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To change the password of a device:
1. In the Connected devices panel, select the device.
2. On the Device tab, in the Information group, click
Properties. Users can
also right-click on the device and click Properties in the context menu.
3. On the General tab, click the Change password button.
4. Enter the old password and confirm a new password in the box that appears,
and then click OK.
5. The software will display a message that the password has been successfully
written. Click OK.

Clearing the Password of a Device
The password that is set on a device can be cleared at any time.
To clear the password of a device:
1. In the Connected devices panel, select the device.
2. On the Device tab, in the Information group, click
Properties. Users can also
right-click on the device and select Properties in the context menu.
3. On the General tab, click the Clear password button. A Password box will appear.
4. Enter the correct password and click OK.

Saving a Device Template
Users can save commonly used device property settings as templates that can be applied to other data loggers of the same model for
future, repeated use.
To save a device template:
1. In the Connected devices panel, select any device.
2. On the Device tab, in the Information group, click
in the context menu.

Properties. Users can also right-click on the device and select Properties

3. Enter in all desired properties for the device. In the dropdown located at the bottom left of the
Properties box, choose New Template.
4. Select Save and a box will prompt to name the device template. Enter a name and select OK. The
template can now be selected to apply the template settings to other data logger of the same
model.
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Channel Settings
Channel settings in the Properties box refer to the renaming of channels. This feature is only available with the OM-CP multi-channel
thermocouple data loggers. There are two channel types for these data loggers, Thermocouple and Ambient. The setting to enable data
recording is always inactive for the Ambient channel and cannot be selected because it works in conjunction with the corresponding
thermocouple channel. (Note: Disabling a thermocouple channel will also disable the corresponding ambient channel.)

Changing the Channel Name of a Device
To change the channel name of a device:
1. In the Connected devices panel, select the device to change the name of the thermocouple channel.
2. On the Device tab, in the Information group, click
in the context menu.

Properties. Users can also right-click on the device and select Properties

3. On the Channels tab, click the Use custom name checkbox to change the name of the thermocouple. Below are examples of the
Channels tab, with default settings and custom settings. (Note: Only the thermocouple channel name can be changed.) If there is no
option to use a custom name, the device does not have the option to rename a thermocouple channel.

An example of the default settings for the thermocouple channels.

An example of the Use custom name checkbox selected and a desired
thermocouple name applied.
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Device Alarm Rules
There are two types of alarm settings: Software Alarm Rules and Device Alarm Rules. To find out more information on alarms that
can be modified in the software, please refer to the Software Alarm Rules section of this manual.

Changing the Device Alarm Rules
To change the Alarm Settings of a device:
1. In the Connected devices panel, select the device.
2. On the Device tab, in the Information group, click
in the context menu.

Properties. Users can also right-click on the device and select Properties

3. Click the Alarm tab. If the Alarm tab is missing, the device does not have any alarm settings.
Configure the Alarm Settings:
1. The High and Low settings indicate reading thresholds at which the alarm
becomes active.
2. The Warn high and Warn low settings indicate reading thresholds at which
the alarm warning becomes active. (Note: Available settings vary per model.)
3. The Delay setting indicates how long to wait before the alarm becomes
active after passing an alarm threshold.
4. The Use cumulative alarm delay checkbox indicates whether or not the
alarm delay should reset when reading values fall back within the alarm
threshold. (Note: Available settings vary per model.)
5. Click the Apply button.

Clearing an Active Device Alarm or Alarm Warning on a Device
To clear an active device alarm or alarm warning on a device:
1. In the Connected devices panel, select the device.
2. On the Device tab, in the Information group, click
in the context menu.

Properties. Users can also right-click on the device and select Properties

3. Click the Alarm tab. If the Alarm tab is missing, the device does not have any alarm settings.
4. In the Alarm tab, do any of the following:
a. Click the Clear alarm button to clear the alarm status so it is no longer active.
b. Click the Clear warning to clear the alarm warning so it is no longer active.
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Trigger Settings
Trigger settings can be configured to allow a device to
automatically begin and stop recording data when certain
reading thresholds are reached. The trigger capabilities of a
device may vary. To change the trigger settings of a device,
please refer to the steps below.

Change the Trigger Settings of a Device
To change the Trigger Settings:
1. In the Connected devices panel, select the device.
2. On the Device tab, in the Information group, click
Properties. Users can also right-click on the device and
select Properties in the context menu.
3. Click Trigger. If the Trigger tab is missing, the device does
not have any trigger settings.

Tri-axial Recorders

4. Configure the Trigger settings. (See the different modes on
this page)

Recording begins when a reading from any axis exceeds the
setpoint value of the axis in either the positive or negative
direction.

5. Click Apply.

Window Mode

Two Point Mode

After a device is started, recording begins when a reading is
below the Low setpoint value or above the High setpoint value. If
either trigger is disabled, the respective setpoint value is ignored.
Disabling both the high and low triggers causes all readings to
be recorded. This applies to devices that support the disabling of
both triggers.

The Start range indicates when recording begins. A reading
must be above the Start high setpoint value or below the Start
low setpoint value to begin recording. The Stop range indicates
when recording ends. A reading must be above the Stop low
setpoint value or below the Stop high setpoint value to end
recording.

The Trigger sample count indicates how many readings each
trigger sample should contain. When the indicated number of
readings is recorded within the current sample, recording ends
until a setpoint value is exceeded again. If the Fill memory on
first trigger checkbox is checked, the sample count is set to the
maximum number of readings the device can record.

When recording ends, any reading outside the Start range will
cause recording to start again.
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Engineering Units
Engineering units display readings in a user selected custom unit of measurement. Engineering units that are stored for use with
reports can be added, changed, or removed. There are two types of Engineering unit levels: Software and Device. Users are able
to create or change the engineering units in both the software level and device level. The user can manipulate the software level
engineering units whenever the software is running, but the device level editing is only available when the connected device
supports the desired engineering units.
The options that are available for creating or changing engineering units include Gain and Offset and High and Low values for
specified conversions. Specification sheets are often available and provide conversions and/or gain and offset values for the sensor
being used.
Software Level
This OM-CP Data Logger Software feature allows the customization of Engineering units. Software level units
(saved in the software specific to the user’s PC, not the device) and functions are the same as non-customized
units. The software level’s engineering units are located on the Device tab in the Information group. When using
the software level engineering units feature with a supported device, users can create a unit and apply it to a
device.
Device Level
This feature is only available when the connected device supports engineering
units. The device level engineering units feature is located in the Engineering Unit
tab in the Properties screen.
There are two methods available for adding an engineering unit: Manually and
using the Engineering Unit Wizard.

Creating an Engineering Unit
Creating an Engineering Unit manually:
1. On the Device tab, in the Information group, click

Engineering Units.

2. Click the Add button.

Adding an Engineering Unit to a device (Device Level)

3. Enter engineering unit information.
4. Click the Save button.
5. Now the new engineering unit will be saved.
Creating an Engineering Unit using the Engineering Unit Wizard:
1. On the Device tab, in the Information group, click

Engineering Units.

2. Click the Wizard button.
3. Complete the wizard steps on the next page.
Creating an Engineering Unit manually
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Creating an Engineering Unit Wizard

1. Click Next on the Getting Started
screen.

2. Select No, just create a unit.

4. Select the measurement and click
Next.

5. Select destination unit and click
Next.

3. Select the base unit type (if
applicable) and click Next.

6. Select how you want to input your
unit data. Refer to the explanations
about the two options in the
calibration section to choose the
appropriate option.

Entering High and Low Values

1. Select High and low values.

2. Select the reference unit and
enter high and low values. Then
click Next.

3. Click Close to exit the wizard.
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Entering Gain and Offset

1. Select Gain and offset.

2. Enter the Gain and Offset and click
Next.

3. Click Close to exit the wizard.

Changing the Engineering Unit of a Device
The engineering unit of a device can be changed to automatically display readings in a custom unit when downloading data. There are
two methods available for changing the engineering unit; the Properties screen, and using the Engineering Unit Wizard.
Changing Engineering Units: Properties (Note: Only data loggers that support engineering units can perform this task)
1. In the Connected devices panel, select the device.
2. On the Device tab, in the Information group, click
Properties. Users can
also right-click on the device and select Properties in the context menu.
3. Click the Engineering Unit tab. If the Engineering Unit tab is missing, the
device cannot use an engineering unit.
4. Make sure the check box next to Enable engineering unit for this device is
selected.
5. Select a Unit.
6. Click the Apply button. Now the selected device will display readings in the
user selected unit.
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Changing the Engineering Units: Engineering Unit Wizard
1. On the Device tab, in the Information group, click

Engineering Units.

2. Click Wizard.
3. Click Next, and then Yes, apply to a device.
4. Select a connected device from the list and click Next. If a unit has not been previously created, see step 3 on page 37 for
instructions on how to create an engineering unit and skip step 5 below.
5. Select a unit from the list.
6. At the Confirm Unit Settings screen, click Write.
7. An alert dialog box will pop up asking to confirm the reset. (Note: All readings on that device will be cleared before applying the
engineering unit.)

#2

#5

#3

#6

#4

#7

Removing an Engineering Unit
Engineering units can be removed at any time.
To remove an Engineering Unit:
1. On the Device tab, in the Information group, click

Engineering Units.

2. Select an engineering unit to remove.
3. Click the Delete button.
4. A message asking if you want to delete the selected unit will appear.
5. Clicking Yes will delete the engineering unit, clicking No will keep the engineering unit.
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Display Settings
Omega offers a variety of OM-CP data loggers that are equipped with an LCD screen. The Display settings refer to the physical display
on the device itself.
To change the display setting of a device:
1. In the Connected devices panel, select the device.
2. On the Device tab, in the Information group, click
in the context menu.

Properties. Users can also right-click on the device and select Properties

3. Click the Display tab. If the Display tab is missing, the device does not have any display settings.
4. Configure the display settings. The number and type of settings displayed may vary depending on the device model. The
following are examples of settings that might be available:
•

Display mode indicates when the device display should appear.

•

Display auto off interval indicates when the device display should automatically shut off.

•

Update mode indicates when the device display should update. If Custom is selected, the Display update interval
indicates how often the display should update.

•

Channel size indicates the text size of channel names on the device display.

•

Backlight mode indicates when the backlight should be on.

•

Pixel mode indicates whether the device display uses inverted colors.

•

Enable LEDs setting indicates whether the device LEDs should activate.

•

Enable buzzer setting indicates whether the device buzzer should be triggered.

5. Click Apply.
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Managing Wireless Devices
Managing wireless devices is simple through the use of the OM-CP Data Logger Software. All OM-CP wireless data loggers require the
use of an interface cable or wireless transceiver to transmit the data back to the software.

Claiming a Wireless Device to the Network
The OM-CP-RFC1000 transceiver connects to the computer and provides the wireless network access for the data loggers. The OMCP-RFC1000 may pick up signals from nearby wireless devices other than the target data logger. To avoid this problem, users can add
wireless devices to the specific network by claiming them. Multiple OM-CP-RFC1000s may be used to extend the range of the network.
To add a wireless device to the network:
1. In the Connected devices panel, ensure that the Only show claimed wireless devices checkbox is unchecked. All wireless
devices that the OM-CP-RFC1000 is receiving signals from will be displayed in the Connected devices panel.
2. Select the device to claim.
3. On the Device tab, in the Wireless group, click

Claim.

4. Now the selected device will be a part of the connected devices panel and users are able to record data/change device settings.
Unless Only show claimed wireless devices is selected in the Connected devices panel, the list of wireless devices will remain in the
Connected devices panel and the claimed device will remain highlighted. Once the Only show claimed wireless devices checkbox is
checked, only the claimed wireless devices will be displayed in the Connected devices panel.

Removing a Wireless Device
When a user no longer needs access to a wireless device, the device may be released.
To release a wireless device:
1. In the Connected devices panel, select the device to release.
2. On the Device tab, in the Wireless group, click

Release.

3. Now the wireless device will no longer be claimed.

Changing the Communication Channel of a Wireless Device
To change the frequency at which a wireless device communicates, the user can change the wireless channel. (Note: After changing
the wireless channel, communication with the device will be lost until all connected OM-CP-RFC1000s are configured to use the same
channel.)
To change the channel of a wireless device:
1. In the Connected devices panel, select the device to change.
2. On the Device tab, in the Information group, click
the context menu.

Properties. Users can also right-click the device and select Properties in

3. Click the Wireless tab. If the Wireless tab is missing, the device does not have any wireless settings.
4. Change the value in the Wireless Channel dropdown menu to the desired setting.
5. Click the Apply button. (Note: To change the selected wireless channel on the OM-CP-RFC1000 transceivers, please refer to the OM-CPRFC1000 product documentation.)

40

Working With Devices

Physically Locate a Claimed Wireless Device
Certain wireless devices can produce a repeated tone to help locate them.
To locate a claimed wireless device in network:
1. In the Connected devices panel, select the device(s) to locate.
2. On the Device tab, in the Wireless group, click
menu.

Locate. Users can also right-click on the device and select Locate in the context

3. The selected device will sound with the repeated tone for a few moments and then it will stop. This action can be repeated as
many times as necessary in order to locate the device(s). If the Locate button is disabled, one or more of the selected devices do
not have this function.
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Managing Data, Folders and Reports
When utilizing the OM-CP Data Logger Software, users have the ability to manipulate the data, folders and reports to streamline
analysis. This chapter provides assistance in achieving optimum organization by outlining steps to create, move, delete or recover
folders and reports. This section will also highlight ways to manage reports and datasets.

Data
OM-CP data loggers can collect a variety of information, and the goal is to make working with the recorded data as seamless as
possible. There are many ways within the software to organize data to accommodate the user. All of those processes will be outlined in
this section.

CSV Files
The OM-CP Data Logger Software has the ability to import a CSV file from older versions of the OM-CP Software. Not all CSV files can be
imported. For more information on A CSV File Failed to Import, please refer to the FAQ section of this manual.
To import a CSV file:
1. Click the File tab, then click Import Files.
2. In the screen that appears, select the files to be imported, then click Open.
To import a folder containing CSV files:
1. Click the File tab, then click Import Folders.
2. In the screen that appears, select the folders to be imported, and then click Select Folder.
To customize the CSV import settings:
1. Click the File tab, then click Options.
2. Click the File button.
3. Under the Importing header, complete one of the following steps:
a. Check Include subfolders to also import CSV files in all subfolders, when selecting a folder in the Import Folders option.
b. In the dropdown menu next to When importing folders, select the storage method to use when importing folders.
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Folders
All of the folders can be found in the File Database panel. The folders are available for organization of
reports and datasets. Folders can be created, renamed, moved to different locations, and deleted.

Create a New Folder
To create a new folder:
1. In the Files Database panel, select the location to contain the new folder.
2. Right-click in the location and select New Folder.

Rename a Folder
To rename a folder:
1. In the File Database select the folder to rename.
2. Complete one of the following steps:
a. Click on the name of the folder, enter a new name, and press Enter.
b. Right-click on the folder and select Rename Folder in the context menu. Enter a new name and press Enter.

Move a Folder
To move a folder:
1. In the File Database panel, select the folder to move.
2. Hold and drag the folder into a different folder.

Delete a Folder
To delete a folder:
1. In the File Database panel, select the folder to delete.
2. Complete one of the following steps:
a. Right-click the folder and select Delete Folder.
b. Hold and drag the folder to the appropriate recycle bin.
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Managing Reports
Reports can be generated in the form of a Graph, Data table, or Statistics view and will be displayed in the Report Display panel. All
saved, example, and deleted reports (as long as they haven’t been permanently deleted) will be located in one of the folders in the
File Database panel. There are many ways to create and manipulate reports to fit the user’s need, which will be detailed in this
section.

Creating a New Blank Report
Users can create a blank graph, data table, or statistics view when creating a new report.
To create a blank report:
1. Click the File tab, then hover or click the expander arrow next to New.
2. Select the type of report to create. Users can also click the Generate button located
in the Graph, Data Table, and Statistics groups of the Report tab. (Note: A report is
automatically generated when double-clicking on a dataset in the Files panel.)

Generating a Report from Another Report
To view the data of a report in a different format, users can generate a new report using the same data. The reports are then linked,
which means that any changes applied to one report are also applied to other reports that are using the same data. To create a new
report using the same data as the selected report without linking them, users will need to create a blank report and add the data
manually.
To generate a report from another report:
1. Open the original report or select the report’s tab or window.
2. On the Report tab, complete one of the following steps:
a. In the Graph group, click

Generate to create a new graph report based on the data of the selected report.

b. In the Data Table group, click
c. In the Statistics group, click

Generate to create new data table report based on the data of the selected report.
Generate to create a new statistics view based on the data of the selected report.

Opening a Report
There are two locations available from which a report can be opened: the internal database or from a file on the user’s computer.
To open a report from the database:
1. On the File Database panel, click the folder that contains the report.
2. In the Files list, double-click the name of the report. Users can also right-click on the report and select Open report in the context
menu.
To open a report from a file:
1. Click the File tab, and then click Open. This will display the Open dialog box. Users can also use the keyboard shortcut Ctrl+O to
display the Open dialog box..
2. In the Open dialog box, browse to the Folder, Drive, Removable media (such as flash drive, CD, or DVD), or Internet location
that contains the file.
3. Select the file, and the click Open.
The Recent Documents list is available from the File tab and can be used to open recent reports. Reports can also be opened through
Windows File Explorer by double clicking the icon. If the software is not running, it will be started and the report will be displayed.
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Saving a Report
A report can be saved to a file or to the internal database. By default, new reports are saved to the Reports folder of the internal
database. A report that has already been saved will be saved to its previous save location.
To save a report:
1. Click the tab or window containing the report to save.
2. Click the File tab, then click Save. The keyboard shortcut to save a report is Ctrl+S. New unsaved reports will now be saved to the
internal database.
To save a report to a file:
1. Click the tab or window containing the report to save.
2. Click the File tab, and then click Save To.
3. Select Save To and click File. The keyboard shortcut to open the Save As dialog box is
ALT+F+A.
4. In the File name box, enter a name for the file.
5. Click Save. The report will now be saved to the selected destination.
To save a report opened from an .MTFF to the internal database:
1. Click the tab or window containing the report to save.
2. Click the File tab, Save To and click File database.
3. The report will now be saved and located in the Datasets folder within the File Database panel.

Closing a Report
To close a window containing a report, use either the File menu or the report window.
To close a report:
1. To close a report from the File menu, with the report window selected, click the File tab, and then choose Close.
2. To close a report from the chart window, on the Report header, click the X.

Changing How a Report Title is Generated
By default, a new report uses a generic title until it is renamed.
Users can change what appears in the title so reports can be
recognized.
To change how a report title is generated:
1. Click the File tab, and then click the Options button
located at the bottom of the menu.
2. Click the Reports tab.
3. Select a Title generation method:
a. None uses a generic title for new reports.
b. Prompt asks for a title for new reports.
c. Automatic creates a title for new reports based on the selectable options under Include the following in automatic title
generation. Users can choose to check any and/or all of the following options in this section:
• Model (Device Type)
• Serial Number
• Device ID
• Download Time
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Renaming a Report
Renaming a report changes the title of the report. There are two ways to rename a report. A report stored in the internal database can
be renamed without opening it. The report must be closed before it can be renamed in the database.
To rename a report in the database:
1. In the File Database panel, select the folder that contains the report to rename.
2. In the File list panel, select the report to rename.
3. Click on the name of the report in the Title column twice. The current title will now be highlighted and can be edited.
4. Be careful not to double-click on the report, which will open the selected report.
5. Enter a new name for the report.
6. Press the Enter key. The report will now have a new name and will retain that name until it is renamed again.
Renaming an Open Report
A report can also be renamed while it is opened. The report must be saved after it has been renamed in order for the new name to be
applied once the report is closed.
To rename an open report:
1. Double-click the tab containing the report to rename. The current title will now be highlighted and can be edited.
2. If the report is in a floating window, right-click the title bar of the report window and select Rename in the context menu.
3. Enter a new name for the report.
4. Press the Enter key, or click OK if using the right-click method.

Exporting a Report to Microsoft Excel®
To see report data in a spreadsheet, users can export reports to Microsoft Excel®. (Note: Only Microsoft Excel® 2003 and later are
supported. Exported data cannot be re-imported.)
Export All Data to Microsoft Excel®
If multiple versions of Microsoft Excel® are installed, the version that was most recently installed will be used to display the data. All the
data included in the report can be exported to Microsoft Excel®, or only a selected portion of the data if desired. If there are more than
one million readings to export, Microsoft Excel® will display the data spanning multiple sheets within a workbook as necessary. The
title of the report carries over to the Microsoft Excel® display chart.
To export all data to Microsoft Excel®:
1. Select the tab or window containing the report to export.
2. On the Report tab, in the Report Options group, click Export to Excel®, then click
Export All Data To Excel®.
3. The Would you like a chart to be displayed? message will appear before Microsoft
Excel® opens:
•

Click Yes: A chart and spreadsheet will open and be located in the Chart and Data tabs respectively.

•

Click No: Only a spreadsheet will open, it will be located in the Data tab.

•

Click Cancel: The command will be canceled and no data will be exported to Microsoft Excel®.
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Exporting Graph Timeslice Data to Microsoft Excel®
Graph data can be selected using a timeslice in order to export only selected data.
To export graph Timeslice data to Microsoft Excel®:
1. Select the tab or window containing the report to export.
2. Select the data to export by creating a Timeslice. (Note: The Timeslice icon is located on the Report tab in the Graph group. For more
information on creating a timeslice, refer to Create a Timeslice with a Graph section of this manual.)
3. On the Report tab, in the Report Options group, click the expander button below Export to Excel®, and then click Export
Selected Data to Excel®.
4. The Would you like a chart to be displayed? message will appear before Microsoft Excel® opens
•

Click Yes: A chart and spreadsheet will open and be located in the Chart and Data tabs respectively.

•

Click No: Only a spreadsheet will open, located in the Data tab.

•

Click Cancel: The command will be canceled and no data will be exported to Microsoft Excel®.

Printing a Report
There are a few different methods available to print reports that will be discussed in this section. There is also a print preview
option available in order to preview what is planned to print before performing the actual print command.
Viewing a Print Preview of a Report
The print preview option allows users to preview what the actual printed report will resemble.
To view a print preview of a report:
1. Open or click the tab or window containing the report.
2. Click the File tab, then choose Print and then click Print Preview. The keyboard shortcut to display the print preview dialog box
is Ctrl+F2.
In the print preview screen, under the Print Preview tab, Margins, Page orientation, Page size, and Zoom of the report can
all be adjusted. The user can also print directly from the print preview screen by clicking the Print icon in the Print group on
the Print Preview tab.
Printing a Report without Using the Print Screen
Using the Quick Print option allows users to print a report without using the print screen. The report will automatically print to the
PC's default printer and will print with the previously selected settings. When Quick Print has been selected there will not be an
opportunity to change any print settings in the print dialog box because it will not appear.
To print a report without using the print screen:
1. Open or click the tab or window containing the report to print.
2. Click the File tab and then hover or click the arrow button next to print, then select Quick Print.

Adding a Dataset to a Report
When a user wants to display additional data within the same view, a dataset can be added to a report.
To add a dataset to a report:
1. Open a report or select the tab or window containing the report.
2. In the File Database panel, select the folder that contains the required dataset. The user can select multiple datasets by holding
the Ctrl or Shift key and either selecting additional datasets or using the arrow keys.
3. Right-click the dataset and click Add to current report. Datasets can also be dragged into the report window.
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Organizing Channels
In the OM-CP Data Logger Software, users can customize how channels are organized within the Channels panel.
To change how channels are organized in a report:
1. Select a report to customize.
2. On the Report tab, in the Channels & Readings group, click Channel Grouping and select one of the
following options:
•
•
•

Serial Number
Device ID
Device Name

Setting the Default Channel Grouping
Setting a default channel grouping means that all new reports will use that channels organization setting.
To set the default channel grouping:
1. Click the File tab and then click Options.
2. Click the Display tab.
3. Click the Group channels by dropdown menu and select one of
the following options:
•
•
•

Serial Number
Device ID
Device Name

Math Channels
Math channels allow data to be displayed as a calculation of other channels, such as an average or sum. Users are able to Add,
Change, and Remove math channels.
To add a Math Channel to a report:
1. Click the tab or window containing the report to add a math channel to.
2. On the Report tab, in the Channels & Readings group, click
Math
Channels. A Manage math channels box will open. Users can also right-click
on a channel in the Channels panel and select Math Channels in the context
menu.
3. Click the Add button. A Manage math channels box will appear. A list of
available math channels will appear in the Math Channels box.
4. Select a channel from the list that appears and click the OK button. When a
channel is selected, its description is shown to the right of the channel title
under Channel Properties.
5. Click the Close button. The new math channel will now be displayed
under the Channels panel and in the open report to which it was added.
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Changing a Math Channel in a Report
To change a Math Channel in a report:
1. Click the tab or window containing a report with a math channel.
2. On the Report tab, in the Channels & Readings group, click
Math Channels. Users can also right-click on a channel in the
Channels panel and click Math Channels in the context menu.
3. Click the math channel to be changed. Make the applicable
property edits to the selected math channel.
4. The user can make changes to the math channel properties in the
right side of the box.

Removing a Math Channel from a Report
To remove a Math Channel from a report:
1. Click the tab or window containing the report to remove a math channel.
2. On the Report tab, in the Channels & Readings group, click
Math Channels. Users can also right-click on a channel in the
Channels panel and select Math Channels in the context menu.
3. Select the math channel to remove.
4. Click Remove. The selected math channel will no longer be listed under the Channels panel or shown on any reports.
5. Click Close.

Changing the Display Unit of a Channel in a Report
The display unit of a channel can be changed in order to modify how the readings are displayed.
To change the display unit of a channel in a report:
1. In the Channels panel, select the channel to change the display unit.
2. Multiple channels can be selected in the Channels panel by holding the Ctrl or Shift key and either selecting additional channels
or using the up and down arrow keys.
3. On the Report tab, in the Channels & Readings group, click the Unit dropdown menu. Select a specific unit from the available
list. The selected channel will now be displayed in the selected unit in any report.

Removing a Channel from a Report
When data is no longer needed from a channel, it can be removed from the report. However, if a report only contains one channel, that
channel cannot be removed.
To remove a channel from a report:
1. In the Channels panel, select the channel to remove.
2. Multiple channels can be selected by holding the Ctrl or Shift key and either selecting additional channels or using the up
and down arrow keys.
3. On the Report tab, in the Channels & Readings group, click
channel and select Remove Channel in the context menu.

Remove Channel. Users can also right-click on the intended

4. To add the channel again, re-add the dataset containing the channel to the report.

49

Managing Folders and Reports

Selecting All Channels of the Same Type in a Report
When a report contains multiple channels of the same type, the user can choose to automatically select them all.
To select all channels of the same type in a report:
1. In the Channels panel, select the intended channel with the desired type.
2. Right-click the selected channel and select Select Like Channels in the context menu.
3. This step can be applied to multiple channels by holding the Ctrl key and selecting a channel of another type before
right-clicking.

Renaming a Channel in a Report
A channel can be renamed in a report to help distinguish it from other similarly named channels. Naming channels is beneficial to
keep things organized.
To rename a channel in a report:
1. In the Channels panel, select the channel to rename.
2. Click the channel name text. Users can also right-click the channel and select Rename in the context menu.
3. Enter a new name for the channel.
4. Press the Enter key.

Viewing Device Properties of a Channel in a Report
To see more information about the device associated with a channel, view the device properties. Device properties cannot be viewed
if the selected channels are associated with different devices.
To view the device properties of a channel in a report:
1. In the Channels panel, click a channel to select. If the report is a graph, users can also click the channel line.
2. On the Report tab, in the Channels & Readings group, click

Device Properties.

Viewing the Properties of a Report
Viewing the properties of a report allows users to see more information about the report.
Report properties can also be printed.
To view the properties of a report:
1. Click the tab or window containing the report.
2. On the Report tab, in the Report Options group, click

P

Report Properties.

3. The Created by and Last modified by fields are based on the name of the computer
user account that was logged in at the time of report creation or modification.

50

Managing Folders and Reports
Optional Sterilization Data in Report Properties
To view F0 and A0 sterilization data in report Properties, it can be added through the Add/Remove icon in the Statistics group,
located in the Report tab.
To set sterilization properties of a report:
1. Open or click the tab or window containing the statistics report.
2. On the Report tab, in the Statistics group, click

Add/Remove. A Manage statistics box will appear.

3. Click the Add button. An Add statistic box will appear.
4. Add either A0 and/or F0. Scroll down to the bottom of the options box to the right of the Current Statistics choices. There will be
a check box to Display sterilization data in report properties, make sure this is selected and hit Close.
5. On the Report tab, in the Statistics group, select Report Properties. The sterilization data for the report will now be displayed.

Moving a Dataset or Report to another Folder
For optimal organization, reports and datasets can be moved to any folder.
To move a dataset or report to another folder:
1. In the File Database panel, select the intended folder that contains the dataset or report to move.
2. Within the selected folder, choose the dataset or report to move. The user can select multiple datasets or reports by holding the
Ctrl or Shift key and either selecting additional datasets or using the arrow keys.
3. Complete one of the following steps:
a. Right-click on the dataset or report and select Move to folder in the context menu, then select the destination folder.
b. Hold and drag the dataset or report into a different folder.

Deleting a Report
Reports and datasets can be deleted at any time. Deleted datasets and reports are moved to the Deleted Reports folder and are able to
be recovered. Once a report or dataset is deleted from the Deleted Reports folder, it is permanently deleted and cannot be recovered.
To delete a dataset or report:
1. In the File Database panel, select the intended folder containing the dataset or report to be deleted.
2. In the Files list, select the relevant report or dataset to delete. To select multiple reports, hold the Ctrl or Shift key and either
selecting additional datasets, or use arrow keys.
3. Complete one of the following steps:
a. Press the Delete key.
b. Right-click the dataset or report and select Delete.
c. Drag the dataset or report to the recycle bin.
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Recovering a Dataset or Report from a Recycle Bin
Deleted datasets and reports are sent to the software Recycle Bins within the File Database panel. This allows users to recover them
as long as they haven't been permanently deleted.
To recover a dataset or report from the software recycle bin:
1. In the File Database panel, select the appropriate recycle bin, depending on whether a dataset or report is being recovered.
2. In the Files list, select the report or dataset to recover.
3. Select multiple datasets or reports by holding the Ctrl or Shift key and either selecting additional datasets or using the arrow keys.
4. Complete one of the following steps:
a. Right-click on the dataset or report and select Restore in the context menu.
b. Drag the dataset or report into a different folder.
c. All of the contents of a recycle bin can be restored by right-clicking the recycle bin and clicking Restore Deleted Items in the
context menu.

Permanently Delete a Dataset or Report from a Recycle Bin
Users can permanently delete datasets and reports from the internal database one at a time or empty a recycle bin to delete all of its
contents at once.
To permanently delete a dataset or report from the software recycle bin:
1. In the Files Database panel, select the appropriate recycle bin, depending on whether a dataset or report is being deleted.
2. In the Files list panel, select the report or dataset to permanently delete.
3. Select multiple reports by holding the Ctrl or Shift key and either selecting additional datasets, or using the arrow keys.
4. Complete one of the following steps:
a. Press the Delete key.
b. Right-click on the dataset or report and select Delete.
c. The entire contents of a recycle bin can be permanently deleted by right-clicking the recycle bin and selecting Empty Deleted
Items in the context menu.
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Graph Reports
Annotations
An annotation provides additional information about a graph or reading. Annotations can contain general information about the
graph or information about a specific reading. An annotation can be titled by double clicking on its header and changing the text.
Annotations in locked graphs cannot be altered. (Note: Annotations are visible when a graph report is printed but not visible when the
report is exported to Microsoft Excel®).

Adding an Annotation to a Graph
A graph annotation is not associated with a reading. Users can add multiple annotations.
To add an annotation to a graph report:
1. Select the graph report requiring the annotation.
Add Annotation
2. On the Report tab, in the Channels & Readings group, click
and then select Add Annotation to Graph. Users can also right-click on the
graph report and select Add graph annotation in the context menu.
3. Annotations added to a graph report can be toggled on and off for visibility
purposes by clicking the pin icon on the top right of the annotation.

Adding an Annotation to a Reading in a Graph

Graph annotation

Users can annotate a specific graph point to provide reading-specific information.
Only one annotation can be added to each reading.
To add an annotation to a reading in a graph:
1. Click the point on a graph to annotate.
2. On the Report tab, in the Channels & Reading group, click
Add Annotation,
and then select Add Annotation to Selected Point. Users can also right-click on
the graph and select Annotate selected point in the context menu.
3. Annotations added to a reading in a graph report, can be toggled on and off for
visibility purposes by clicking the pin icon on the top right of the annotation.

Reading-specific annotation

Creating a Timeslice with a Graph
To see data based on a portion of a graph, a Timeslice can be created. This will allow data tables and statistic reports to be viewed
with only the timeslice data present.
To create a timeslice with a graph:
1. Open or click the tab or window containing the graph of which to create a timeslice.
2. On the Report tab, in the Graph group, click

Timeslice.

3. Select the check box next to Enable Timeslice.
4. The size of the highlighted area can be adjusted by doing one of the following:
a. Drag an outer edge of the Timeslice.
b. Change the Start or End value.
c. Drag the timeslice to move the highlighted area.
d. Choose Select all to highlight all the data on a graph.
e. Choose Select Current Time Scale to highlight all the data within the current time scale of the graph.
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Cooling Flags
Cooling flags are automatic reading annotations that specify
when certain temperature thresholds are met. Users can set the
default cooling flags, as well as manage cooling flags that have
already been created.

Managing the Cooling Flags of a Graph
Managing the cooling flags of a graph allows the user to freely
adapt the graph to meet requirements and simplify the search for
changes in the data regarding the variations of temperature.
To manage the cooling flags of a graph:
1. Select the graph to manage the cooling flags.
2. On the Report tab, in the Graph group, click

Cooling Flags.

3. Do any of the following:
a. Check or uncheck the Display cooling flags checkbox to toggle when the cooling flags
are displayed.
b. Configure the names and thresholds of the cooling flags to display. The number of flags
to display can be adjusted with the Add and Remove buttons.
4. Set the cooling flags to be the default for all new graphs by clicking Set as default.

Setting the Default Cooling Flags
Setting default cooling flags means that all new graphs will automatically use the cooling flags chosen.
To set the default cooling flags:
1. Click the File tab, and then click Options.
2. Click the Display tab.
3. Click the Cooling Flags button and set the intended cooling flags, click OK.
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Value Lines
A Value Line is a visual horizontal line on a graph report representing a specific calculation or user selected value within the recorded
data. There are five options for Value Line types; Minimum, Maximum, Average, Mean Kinetic Temperature (MKT) or Fixed Value.
A Fixed Value line represents a specific value on a graph report that is selected by the user and can be changed at any time.
Minimum, maximum, average or MKT values are calculations based on the recorded data for that parameter. Existing Value Lines will
automatically be converted when the graph unit changes. For example, the value line with an initial value of 0 °C will automatically
recalculate to +32 °F when the user changes the units from Celsius to Fahrenheit. When a unit conversion is not possible, the line will
not be displayed. Value Lines are saved along with a graph report and are available to the user when that report is reopened. (Note:
When recording data in real time, calculated value lines will automatically recalculate to reflect the new data.)
To add a value line to a graph:
1. Open or click the tab or window containing the graph report of which to add
a value line.
2. On the Report tab, in the Graph group, click
Value Lines. Users can also
right-click on the graph report and hover over Value Lines and select Add
value line in the context menu.
3. Select a line type in the dialog that appears and click OK.
To change a value line in a graph:
1. Open or click the tab or window of the graph report with Value Lines to be edited.
2. On the Report tab, in the Graph group, click
Value Lines. Users can also right-click on the graph report and hover over Value
lines and select Manage value lines in the context menu.
3. Select the value line to be changed from the left pane, then make the applicable property modifications and click Close. (Note:
Users can toggle the visibility of value lines by right-clicking on the graph report, clicking Value lines, then clicking a line in the list. Up
to six value lines can appear in the context menu.)
To remove a value line from a graph:
1. Open or click the tab or window of the graph report with Value Lines to be removed.
Value Lines. Users can also right-click on the graph report and hover over Value
2. On the Report tab, in the Graph group, click
lines and select Manage value lines in the context menu.
3. Select the value line to be deleted from the left pane and click Remove.
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Time Markers
A Time Marker is a visual representation of a specific time within the recorded data. It appears as a vertical line on a graph report or
a colored row in a data table. Time markers are organized into collections. Modifications to the properties of a collection will apply
settings to all Time Markers within that collection.
To add a time marker in a graph or data table:
1. Open or click the tab or window containing the report to add a time
marker.
2. On the Report tab, in the Channels & Readings group, click
Time Markers.
3. Click Add. Users can also right-click on a graph report and hover
over Time markers and select Add time marker in the context
menu. (Note: To add a time marker to a data table, right-clicking is
not an option. Use the Time Markers icon in the Channels & Readings
group on the Report tab.)
4. Select the desired properties and click Close.
To change a time marker in a graph or data table:
1. Open or click the tab or window containing the report to change a time marker.
2. On the Report tab, in the Channels & Readings group, click
Time Markers. Users can also right-click on a graph report and
hover over Time markers and select Manage time markers in the context menu. (Note: To add a time marker to a data table,
right-clicking is not an option. Use the Time Markers icon in the Channels & Readings group on the Report tab.)
3. Click the time marker to change, then make the applicable property modifications and click Close. (Note: Users can toggle the
visibility of time marker collections by right-clicking on the graph, clicking Time markers, then clicking an item in the list. Up to six
collections can appear in the context menu.)
To remove a time marker in a graph or data table:
4. Open or click the tab or window containing the report to remove a time marker.
5. On the Report tab, in the Channels & Readings group, click
Time Markers. Users can also right-click on the graph report and
hover over Time markers and select Manage time markers in the context menu. (Note: To remove a time marker in a data table,
right-clicking is not an option. Use the Time Markers icon in the Channels & Readings group on the Report tab.)
6. Click the time marker collection to remove, or when in a time marker collection, click the time marker to delete then select Remove.

Automatically Scroll a Graph during Real Time Recording
When a device is recording in real-time, a graph displaying the data can be set to automatically scroll horizontally so the most recent
readings are always displayed.
To automatically scroll a graph during real time recording:
1. Select the graph report.
2. On the Report tab, in the Graph group, click Enable Autoscroll.
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Showing or Hiding the Time Zone on the Horizontal Axis of Graphs
Users can choose to show or hide the time zone on the horizontal axis of graphs. This will display the time zone in which the
current graph report was downloaded.
To show or hide the time zone on the horizontal axis of graphs:
1. Click the File tab, and then click Options.
2. Click Display, then check or uncheck the Display time zone on the horizontal axis of graphs checkbox, click OK.

Locking the Vertical Scale of a Graph
The vertical scale of a graph can be locked to prevent any automatic adjusting from occurring when new data is added. Any values that
lie outside the displayed range will not resize the graph view.
To lock the vertical scale of a graph:
1. Select the graph report.
2. On the Report tab, in the Graph group, click

Lock Vertical Scale.

3. The Vertical scale will be locked and unable to be scrolled.

Setting the Vertical or Horizontal Scale of a Graph
Users can set the value, unit, and time on the vertical or horizontal scale of a graph.
To set the vertical or horizontal scale of a graph:
1. Select the graph report to customize.
2. On the Report tab, in the Graph group, click
appears.

Set Scale. The Set graph scale box

3. Complete one of the following steps:
a. Change the Time Scale values to determine how the horizontal axis should be
displayed.
b. Change the Vertical Scale values to determine how the vertical axis should be displayed.
c. Change the Unit to convert the vertical axis and all associated channels to the selected unit.
4. Click OK.

Moving a Vertical Axis of a Graph
To move a vertical axis to the left or right side of a graph:
1. Open the graph report, or select it if it is already open.
2. On the Report tab, in the Graph group, click
Alignment box will open.

Axis Positions. The Axis

3. Complete one of the following steps:
a. To move an axis to the right side, select one or more axes in the list on the left, and then click the Move right button.
b. To move an axis to the left side, select one or more axes in the list on the right, and then click the Move left button.
c. Drag one or more axis to or from either list for desired display location.
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Independently Set the Scale Units of a Graph
This feature allows users to independently edit the scale and position of individual channels within a graph report to optimize
presentation. Scaling preferences are saved along with the graph and are applied when the report is reopened. (Note: Exporting the
graph to Microsoft Excel® will not retain the set scale modifications due to how Microsoft Excel® translates the data.)
To independently set the scale units of a graph:
1. Open the graph report, or select it if it is already open.
2. Hover over the vertical axis of a graph report and hold the Ctrl key. Click and drag up or down to set the scaling of each
channel separately.

Setting the Units and Colors Used to Display Readings
Data is normally displayed in the units and colors defined by each channel of a device. Setting unit preferences means that any new
data downloaded will initially display in the selected units. Existing data will remain unchanged, and users are also able to clear any
preferences previously set.
To set display units and colors:
1. Click the File tab, and then click Options.
2. Click the Units tab.
3. Select the unit options to use for new data by clicking the dropdown
menus under the Preferred Unit column.
4. Select a preferred color to use for new data by clicking the colored
square under the Color column.

Clearing Unit Preferences
All unit preferences can be cleared so that the original default units and colors are used.
To clear unit preferences:
1. Click the File tab, and then click Options.
2. Click the Units tab.
3. Click the Clear unit preferences button.
4. The units and colors will be returned to the default.

Graph Line Preferences and Background Color
Changing the Background Color of a Graph
A graph’s background color can be changed to customize how a graph is visually represented.
To change the background color of a graph:
1. Select the graph to customize.
2. On the Report tab, in the Graph group, click
Background color and select a color. If the intended
color is not present, click More Colors… to customize a hue.
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Setting the Default Graph Background Color
Setting a default graph background color means that all new graphs will be visually represented in the selected color.
To set the default graph background color:
1. Click the File tab, and then click Options.
2. Click the Reports tab.
3. Click the color square next to Background color, a Choose a color box will appear.
4. Select the desired color, and then click OK.
5. The default graph background color will now be the new selection, and all new graphs will appear with this color background.

Changing the Color of a Line in a Graph
Along with changing the background color of a graph, users are also able to change the color of a
specific line in a graph.
To change the color of a line in a graph:
1. In the Channels panel, select the intended channel to change the color.
2. Multiple channels can be selected in the Channels panel by holding the Ctrl or Shift key and
either selecting additional channels or using the up and down arrow keys.
3. On the Report tab, in the Graph group, click Line Color and select a color. The following
color options are available. Above is an example of the Background color options.
4. If the intended color is not present, click More Colors… and the following box will appear to
customize a hue.
5. Now the selected channel will be displayed on the graph in the new selected color.

Line Thickness
In addition to changing the color of a line in a graph, the thickness of a line in a graph can be changed in order to make it stand out
more or less. This is helpful when there are many channels displayed on one graph.

Changing the Thickness of a Line in a Graph
To change the thickness of a line:
1. In the Channels panel, select the intended channel, or click the line in the graph.
2. Multiple channels can be selected in the Channels panel by holding the Ctrl or Shift key and either selecting additional channels
or using the up and down arrow keys.
3. On the Report tab, in the Graph group, type or select a number between 0.5–20 in the Line thickness box.
4. The thickness of the selected line will change according to the chosen setting.

Setting the Default Line Thickness
Setting a default line thickness means that all channels of a dataset added to a graph use the line thickness setting chosen.
To set the default line thickness:
1. Click the File tab, and then click Options.
2. Click the Reports tab.
3. Choose the line thickness using the selector on the line thickness scale.
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Changing the Application Color Scheme
Appearance of the software can be changed by selecting a different color scheme.
To change the application color scheme:
1. Click the File tab, and then click Options.
2. Click the Display tab, and then select a theme from the dropdown menu
next to Color scheme in the Layout section. The image to the right is an
example screen of the Options, Display tab and Layout section.

Setting the Default Language
Users can set the default language for the OM-CP Data Logger Software.
To change the default language:
1. Click the File tab, and then click Options.
2. Click the Display tab, scroll down to the bottom where language is located. Select the default language from the dropdown menu
and select OK.

Data Table Reports
Using a data table report allows the user to view the data and channels from the current graph or statistics report in a data table
format. In addition, data table reports can also be exported to Microsoft Excel®. Users are also able to generate a blank data report if
there is no current report open. For more information on how to generate a data table report, please refer to the Create a New Blank
Report and Generating a Report from Another Report sections of this manual.
Data table reports can also display Time Markers. Time Markers can be added while the data table report is open by clicking
Markers in the Report tab under the Channels & Readings group.

An example of a Time Marker made in a Data Table Report to show the
beginning of a time frame.

Time

An example of a Time Marker in a Data Table Report to show the end
of a time frame.
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Statistics Reports
When using a statistics report, statistic calculations can be added, changed, or removed from the report. This will provide optimal
information about the report readings and the relationship between the readings.

Adding a Statistic
To add a statistic:
1. Open or click the tab or window containing the statistics report.
2. On the Report tab, in the Statistics group, click
Manage statistics box will appear.

Add/Remove. A

3. Click the Add button. An Add statistic box will appear.
4. Select the statistic to add, and then click the OK button. When a statistic is
selected, the description is show to the right of the statistic title.
5. Click the Close button.
6. A new statistic will now be displayed in the selected statistics report.

Setting Default Statistics
Setting the default statistics allows the user to select the statistics that appear by default when creating a report. Default statistic are
stored in the OM-CP Data Logger Software preferences on the local PC being used and can be modified or deleted by other users with
access to the software.
To set default statistics:
1. Click the File tab, and then click Options.
2. Click the Reports tab, and then select Default Statistics.
3. From the Default Statistics box, select the desired statistics by either Adding or Removing. To change how they appear in order
of importance, highlight the statistic and use the up and down arrows.

Changing the Properties of a Statistic
To change the properties of a statistic:
1. Open or click the tab or window containing the statistics report to change.
2. On the Report tab, in the Statistics group, click

Add/Remove.

3. Select the statistic to change the properties of from the Current Statistics list.
4. Enter the information into the appropriate section under the statistic title. If no parameters are listed, the selected statistic does
not require additional information.
5. Click the Close button.

Removing a Statistic
To remove a statistic:
1. Open or click the tab or window containing the statistics report.
2. On the Report tab, in the Statistics group, click

Add/Remove.

3. Select the statistic to remove.
4. Click the Remove button.
5. Click the Close button.
6. The selected statistic will no longer be listed on the statistics report.
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Time to Threshold Statistic
The Threshold Statistic option allows users to add statistics regarding the duration of time it took to reach a specific measurement,
one value for ascending and one for descending. Multiple statistics can be added.
To add threshold statistics:
1. Open or click the tab or window containing the statistics report.
2. On the Report tab, in the Statistics group, click

Add/Remove. A Manage statistics box will appear.

3. Click the Add button at the bottom to display the Add statistic box.
4. Scroll down the list to Time to Threshold (ascending) or (descending), select and then click OK to add either one.
5. Click the Close button. A new statistic will now be displayed in the selected statistics report.

Sterilization Data
Optional F0 and A0 sterilization data can be added to a statistics report.
To add sterilization data to a statistics report:
1. Open or click the tab or window containing the statistics report.
2. On the Report tab, in the Statistics group, click

Add/Remove. A Manage statistics box will appear.

3. Click the Add button. An Add statistic box will appear.
4. Add either A0 and/or F0. Scroll down to the bottom of the options box to the right of the Current Statistics choices. There will be
a check box to Display sterilization data in report properties, make sure this is selected and hit Close. Sterilization data will
now be visible in the statistics report.

Maintenance
OM-CP data loggers do not require a great deal of maintenance. Like most high-tech devices, they do require services in order to
extend the life of the data logger. Contact Omega for firmware and software updates.
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Troubleshooting
This section of the manual contains information that will help users answer questions to correct common connection missteps or
other errors while using the software or devices.

Why are my Devices not Appearing?
Sometimes a device connected to the computer does not appear in the Connected devices panel. This is often due to a minor
connectivity issue. If a data logger does not show up in the Connected devices panel, or an error message is received while using a
data logger, try the following:
1. Check that the interface cable is properly connected to the PC and the data logger.
2. Ensure that the battery in the data logger is not discharged. For best voltage accuracy, use a voltage meter or multi-meter
connected to the battery of the device. Alternatively, try swapping out the battery of a device that is connecting successfully, if one
is available.
3. Ensure that no other data logging software is running.
4. Ensure that the Connected devices panel is large enough to display devices. This can be verified by positioning the cursor on the
edge of the Connected devices panel until the resize cursor appears, then dragging the edge of the panel to resize as necessary.

Interface Cables
Check that the software recognizes the interface cable. If a device is not appearing in the Connected devices panel, it may be that the
interface cable is not properly connected.

Check that the Software Recognizes the
Interface Cable
To check that the software recognizes the interface cable:
1. In the software, click the File tab, and then click Options.
2. In the Options window, click the Communications tab.
3. The Detected Interfaces box will list all of the available
communication interfaces. If an interface cable is listed, the
software has correctly recognized it and is ready to be used.

Check that Windows Recognizes the Interface Cable
If the software does not recognize the interface cable, there may be a problem with Windows or the USB drivers.
To check that Windows recognizes the interface cable:
1. On the Windows desktop, click Start, right-click Computer and choose Properties. Windows+Break can be selected as a
keyboard shortcut.
2. Click Device Manager.
3. In the Options window, click Communications. Depending on the type of interface cable in use, choose one of the following
steps accordingly:
• Interface cables that use OM-CP drivers: (old OM-CP-IFC200, OM-CP-IFC300, OM-CP-IFC400, OM-CP-RFC1000)
1. Click Universal Serial Bus Controllers.
2. Look for an entry for Data Logger Interface.
• If the entry is present, and there are no warning messages or icons, then windows has correctly recognized the
interface cable.
• If the entry is not present, or has an exclamation point icon next to it, USB drivers may need to be installed.
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• Interface cables that use Windows drivers: (new OM-CP-IFC200/202)
1. Click Human Interface Devices.
2. Look for one or more entries listed as HID-compliant device. If there are no entries, Windows has not recognized the
interface cable.
3. Right-click the entry and choose Properties.
4. In the Properties window click the Details tab.
5. From the Property combination box, choose the Hardware ID's item.
6. Verify that the Hardware ID string HID/VID_10C4&PID_8748 is present.
• If the entry is present, and there are no warning messages or icons, then windows has correctly recognized the
interface cable.
• If the entry is not present, or has an exclamation point icon next to it, USB drivers may need to be installed.

Ensure that the USB End of the Interface Cable is Securely Connected to the Computer
To ensure that the USB end of the interface cable is securely connected to the computer:
1. Identify the type of interface cable being used.
2. Locate the USB-A plug of the interface cable.
3. If the interface cable is connected to the PC, unplug it.
4. Wait ten seconds, and then reinsert it.
5. Check to make sure that the blue LED is lit, indicating a successful connection.

Installing the Interface Cable Drivers
1. Identify the type of interface cable.
2. For assistance in identifying the interface cable type, see Interface Cables on the previous page.
3. If the interface cable is one of the following types, drivers must be installed:
•
•
•
•
•

OM-CP-IFC200 (box style)
OM-CP-IFC300
OM-CP-IFC400
OM-CP-IFC406
OM-CP-RFC1000

4. See page 7 for installation of USB Interface Drivers.
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FAQ
What is the Difference between a Dataset and a Report?
• A Dataset is the data downloaded from a device. This data cannot be altered.
• A Report is what is displayed when a dataset is opened: a visual representation of the data that can be changed as necessary. Any
changes to the report, such as removing channels or using the timeslice feature, are not applied to the underlying
datasets. Available report types are graph, data table, and statistics view.

How can a Composite Graph be Generated?
A Composite graph can be created by adding multiple datasets to any open graph. For more information on composite graphs, refer
to the Adding a Dataset to a Report section of this manual.

A CSV File Failed to Import
A CSV file might fail to import if it:
• Already exists in the software’s file database
• Was saved in Microsoft Excel®
• Has been edited after being saved in an older version of OM-CP Software
• Was exported
• Is empty
• Has no readings
• Was saved in a version of OM-CP software earlier than 2.02

Resetting the Screen Layout
To restore all windows to their original positions, reset the screen layout.
To reset the screen layout:
1. Click the File button, and then click Options.
2. Click Display.
3. Click the Reset screen layout button.
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Retrieving the Version Number of the Software and Other Components
Users can check which version of the software is installed and obtain information about other software components.
To get the version number of the software as well as other components:
1. Click the File button, and then click Options.
2. Click the About button.
3. The following information is available in the About window:
•

Version is the software version.

•

DLL version is the version of the software component that allows
device communication.

•

USB driver version is the version of the driver that detects USB-based
device communication cables.

•

USB file version is the version of the software component that
allows communication between the software and USB-based device
communication cables.

•

The contact information of the company.

•

Registered user.

•

There is a button available to view the legal notice.

Error Messages
Error messages could potentially appear when using the OM-CP Data Logger Software. To resolve any error message that is not listed
here, please contact a member of the Omega Technical Support team.

"Configuration Update Timed Out"
The Configuration update timed out message means that the software sent a request to the data logger but did not receive a
response.
The following suggestions may help solve the problem:
1. First, attempt to retry the operation. Due to the ultra-low power nature of the data logger, some communications may be missed
and will need to be retried.
2. Check that the device is properly connected to the interface cable. For more information, please refer to the Why are my Devices
not Appearing? section of this manual.
3. Restart the software.
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The information contained in this document is believed to be correct, but OMEGA accepts no liability for any errors it contains, and reserves the
right to alter specifications without notice.

WARRANTY/DISCLAIMER
OMEGA ENGINEERING, INC. warrants this unit to be free of defects in materials and workmanship for a period of 13 months
from date of purchase. OMEGA’s WARRANTY adds an additional one (1) month grace period to the normal one (1) year product
warranty to cover handling and shipping time. This ensures that OMEGA’s customers receive maximum coverage on each product.
If the unit malfunctions, it must be returned to the factory for evaluation. OMEGA’s Customer Service Department will issue an
Authorized Return (AR) number immediately upon phone or written request. Upon examination by OMEGA, if the unit is found
to be defective, it will be repaired or replaced at no charge. OMEGA’s WARRANTY does not apply to defects resulting from
any action of the purchaser, including but not limited to mishandling, improper interfacing, operation outside of design limits,
improper repair, or unauthorized modification. This WARRANTY is VOID if the unit shows evidence of having been tampered with
or shows evidence of having been damaged as a result of excessive corrosion; or current, heat, moisture or vibration; improper
specification; misapplication; misuse or other operating conditions outside of OMEGA’s control. Components in which wear is not
warranted, include but are not limited to contact points, fuses, and triacs.
OMEGA is pleased to offer suggestions on the use of its various products. However, OMEGA neither assumes
responsibility for any omissions or errors nor assumes liability for any damages that result from the use of its
products in accordance with information provided by OMEGA, either verbal or written. OMEGA warrants only
that the parts manufactured by the company will be as specified and free of defects. OMEGA MAKES NO OTHER
WARRANTIES OR REPRESENTATIONS OF ANY KIND WHATSOEVER, EXPRESSED OR IMPLIED, EXCEPT THAT OF
TITLE, AND ALL IMPLIED WARRANTIES INCLUDING ANY WARRANTY OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE HEREBY DISCLAIMED. LIMITATION OF LIABILITY: The remedies of purchaser set forth
herein are exclusive, and the total liability of OMEGA with respect to this order, whether based on contract, warranty,
negligence, indemnification, strict liability or otherwise, shall not exceed the purchase price of the component upon
which liability is based. In no event shall OMEGA be liable for consequential, incidental or special damages.
CONDITIONS: Equipment sold by OMEGA is not intended to be used, nor shall it be used: (1) as a “Basic Component” under 10
CFR 21 (NRC), used in or with any nuclear installation or activity; or (2) in medical applications or used on humans. Should any
Product(s) be used in or with any nuclear installation or activity, medical application, used on humans, or misused in any way,
OMEGA assumes no responsibility as set forth in our basic WARRANTY / DISCLAIMER language, and, additionally, purchaser will
indemnify OMEGA and hold OMEGA harmless from any liability or damage whatsoever arising out of the use of the Product(s) in
such a manner.

RETURN REQUESTS / INQUIRIES

Direct all warranty and repair requests/inquiries to the OMEGA Customer Service Department. BEFORE RETURNING ANY
PRODUCT(S) TO OMEGA, PURCHASER MUST OBTAIN AN AUTHORIZED RETURN (AR) NUMBER FROM OMEGA’S CUSTOMER
SERVICE DEPARTMENT (IN ORDER TO AVOID PROCESSING DELAYS). The assigned AR number should then be marked on the
outside of the return package and on any correspondence.
The purchaser is responsible for shipping charges, freight, insurance and proper packaging to prevent breakage in transit.
FOR WARRANTY RETURNS, please have the following
information available BEFORE contacting OMEGA:
1. Purchase Order number under which the product was
PURCHASED,
2. Model and serial number of the product under warranty, and
3. Repair instructions and/or specific problems relative to the
product.

FOR NON-WARRANTY REPAIRS, consult OMEGA for current
repair charges. Have the following information available BEFORE
contacting OMEGA:
1. Purchase Order number to cover the COST of the repair,
2. Model and serial number of the product, and
3. Repair instructions and/or specific problems relative to the
product.

OMEGA’s policy is to make running changes, not model changes, whenever an improvement is possible. This affords our customers the latest in technology and
engineering. OMEGA is a registered trademark of OMEGA ENGINEERING, INC.
© Copyright 2016 OMEGA ENGINEERING, INC. All rights reserved. This document may not be copied, photocopied, reproduced, translated, or reduced to any electronic
medium or machine-readable form, in whole or in part, without the prior written consent of OMEGA ENGINEERING, INC.

